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PROGRAM NAME GOES HERE 
 

“Episode Title Goes Here” 
 

Prod. #27 
 
 

CAST 
 
 
ANNOUNCER    The announcer. 
CHARACTER NAME #1  Brief character description. 
CHARACTER NAME #2  Nervous novice writer. (Age 14) 
 
NOTE:  
The above list is for a cast of XX. A smaller cast of X can be used if 
the following roles are combined for one actor each: 
 
CHARACTER #5/CHARACTER #6 
CHARACTER #7/CHARACTER #8/CHARACTER #9 
 
 
Four sound effects artists are also required. 
Two walla walla artists are also required. 
 
 
Visit Tony Palermo’s Radio Drama Resources website:http:/www.RuyaSonic.com 
 
NOTE: To make better use of this template, go to my website listed 
above and read my “Radio Drama Resources” articles and lessons on 
Writing, Engineering, Directing, Scoring, and Sound Effects. They’ll 
fill you in on what the various conventions of this radio script format 
mean--things such as why the music cues have a box with [A-4] and other 
bits that I don’t want to cram into this template. My very detailed  
lesson in writing clear radio drama cues is found at: 
http://www.RuyaSonic.com/wrt_cues.htm  
 
NOTE: At the very end of this document you will find instructions for 
how to make good use of the template. 
 
NOTE: This template uses headers and footers, like the one below with 
the production company address. You’ll want to change the titles and 
other info, and because I use multiple sections in the document, you’ll 
need to change them in each section. It’s easy. Go to the “View” menu 
and click on “Headers and Footers” then maneuver around and change 
them. Word's search and replace feature is handy for these kind of 
changes. 
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Episode Title Goes Here 

1. MUSIC: [A-1] PROGRAM THEME--UP. ESTABLISH. CONTINUE 

UNDER. 

2* ANNOUNCER: Yes, friends! It’s time for Blah blah 

blah... Today's story: "Episode Title Goes 

Here.” (PAUSE) 

And, please notice the use of bold 12-point 

courier font everywhere in the script--

that’s because it photocopies better.  

PRODUCTION NOTE: 
This kind of note is for instructions. I’m using this 
right now to inform the writer that I’ve included an MS 
Word toolbar in this template. If you click on the menu 
for “View” and go to the “Toolbar” tab, you can click on 
a toolbar for “Radio Script” and it’ll pop up some 
buttons that allow quick formatting of text for notes, 
sound, music and dialogue styles. Also, use the “page 
layout view” of the script--it’s more life-like. OK, 
back to scene... 

3. MUSIC: [B-2] ACTION THEME--UP FULL. FADE. 

SCENE ONE:  EXT. TRAIN STATION - DAY 
 (ANNOUNCER, CHARACTER #1) 

4. SOUND: LIVE SOUND EFFECT GOES HERE. GUNSHOT (4X) 

WALLA--PASSENGERS GRUMBLING. 

5. ANNOUNCER: That was four gunshots--one for each “X”. 

Blah Blah Blah with underline used for 

emphasis... and that ellipsis to tell actors 

to slow their delivery, then pick up later. 
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1. CHARACTER 1: (SARDONICALLY) I got a present for ya! 

2. SOUND: SWORD UNSHEATHED. WALLA--CROWD GASPS. 

SCENE TWO:  INT. MUSIC HALL - MOMENTS LATER 
 (ANNOUNCER, CHARACTER #2, CHARACTER #3) 

3. MUSIC: [A-3] EXOTIC THEME--UP AND UNDER.  

4* ANNOUNCER: Please note that each new page restarts the 

numbering scheme for ALL cues. This allows 

quick references to “page 4, cue #2” when 

rehearsing. But, look! Here comes Character 

number one. Notice how I spelled out the 

number? My, but this fellow looks dazed... 

5. CHARACTER #1: The last thing I remember was pulling a 

sword on everyone at the train station. 

6. CHARACTER #2: Well, we changed scenes and if the character 

is speaking the last line in a scene and 

then the first line in a new scene, the 

audience doesn’t know what is going on. So 

either the announcer speaks for a moment or 

you add somebody--like me--to your script. 

7. SOUND: CHARACTER #3'S FOOTSTEPS--RUN UP, STOP. 

8* CHARACTER #3: (OUT OF BREATH) I try to keep all of a 

character’s lines on a page, but sometimes 

you run out of 

(MORE...) 
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1. CHARACTER #3 (CONT’D) room. Then you have to use this 

“more” and “continued” trick. Just like in 

the movies. Try to break at the end of a 

sentence, though--or the actor suffers. 

2. SOUND: CHARACTER # 4 DOORKNOCK (3X) OPENS. 

3* CHARACTER #4: (DISTANT) But what about me? I’m on the 

other side of the room! 

4. CHARACTER #1: Blah Blah blah, as I walk off mic. (EXITING) 

5. CHARACTER #2: My, but this script is just full of dialogue 

demonstrating radio writing conventions. You 

can delete all this junk and save the 

template as radio_script_blank.dot.  

6. MUSIC: [B-4] CLOSING THEME--UP. CONTINUE UNDER. 

ENGINEER'S NOTE: 
The [B-4] in the music cue above indicates playback 
device "B" and track number "4"—as in CD player "B", 
track "4." It's nice to have two playback devices, so I 
can have [A-5] if that cue comes right on the heels of 
[B-4]. You can also use something like [A-5S] to 
indicate that A-5 is a sampled sound effect—rain, for 
example. 

7* ANNOUNCER: Join us again next week for another exciting 

adventure of "Program Name Goes Here!" This 

has been a production of the company name 

goes here. So long! 

2. MUSIC: CLOSING THEME--FADES. 

THE END. 
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Writer/Director’s notes for “Episode Title Goes Here” 
 
NOTE:  
This is where the writer or director can include general notes on how to 
interpret the script. It will explain delivery or character shadings, 
sound effects, or musical instructions, and discuss technical issues such 
as how to use reverb or walla walla. 
 
If necessary, I often include the back story for a multi-part program or 
a description of the genre and background that the production crew may 
find useful.  
 
For an example of the kind of notes I provide in my own scripts, see my 
page of program notes on my Radio Drama Resources website: 

tp://www.RuyaSonic.com/script_notes.htm ht
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Radio Skills School
 
Microphone Technique: 
1) Sensitive and dead areas. Don’t touch!  
2) Proximity effect. (Boomy if too close.) 
3) Proper distance for radio acting. 
4) Dynamics and distance. (Back off to yell.) 
5) Off-mic use for distant sounds. Asides. 
6) Popping “P”s and S-S-S-Sibilance. 
7) Mic safety. (hitting, blowing, dropping) 
8) Assume every mic is always ON. 
9) Quiet script page turning. 
 
Radio Acting: 
1) Quiet in the studio. 
2) Don’t cough, laugh, or talk during production. 
3) Watch the director. Wait for your cue. (Q) 
4) Speed equals excitement. Don’t bore the audience. 
5) Jump in if there’s dead air. 
6) Wait for director’s signal at end of show. 
 
Radio Direction “Sign Language” 
1) “Wait.”  Open hand. 
2) “5-4-3---” Finger count down. 
3) “You’re on.” Pointing finger. 
4) “Quicken the pace.” Finger draws circles. 
5) “Stretch it out.” Pulling taffy. 
6) “Louder.” Pull ear. 
7) “Quieter.” Finger to lip (Shhhh-style) 
8) “Cut.” Finger slits throat. 
9) “Come in” or “Back off” microphone. 
 

NOTE:  
The next two pages cover the casting monologues and casting 
sheet listing the characters. The director uses this to cast 
the show. 
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Program Name Goes Here Casting Monologues  
 

CASTING EVALUATION:    Date: __________ 
 
“Episode Title Goes Here”  (# of actors required - # of SFX artists) 
 
________________ ANNOUNCER    The announcer.   
________________ CHARACTER NAME   Nervous writer.(Age 34) 
________________ CHARACTER NAME   Brief character desc. 
________________     -also- MINOR PART  A nasty henchman. 
 
 
============================================================ 
Audition ratings: A through F 
 
Actor Name Rating Bold?  Emotion? Accents Role? Notes 
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“Episode Title Goes Here”
 
CASTING MONOLOGUES: 
 
All actors are asked to read some lines, called “sides,” aloud, to audition. The director will cast the roles 
in our production based upon these readings. Please take a moment to read the lines below several times, 
both silently and aloud. These monologues can also provide some “back story,” giving an idea of who the 
characters are and what kind of story we are producing. Since radio actors often play several parts, we 
encourage the use of different voices or accents when auditioning for the different roles.  
 

ANNOUNCER: I’m the announcer. I quickly describe the 

setting for each scene and report on all 

spine-tingling suspense for the radio 

listener. These lines often include underlined 

phrases to instruct the actor to stress or 

emphasize or just read the underlined words 

slower. 

CHARACTER #1: Hello, I’m Character #1, this text describes 

me and contains certain typical phrases I use. 

It is to educate the cast and crew about the 

characters before we begin work. Also, by 

giving a fairly long speech--in character--a 

director can evaluate my voice for its tone 

and my ability to read a script--live--well. 

CHARACTER #2: I’m Character #2, this text describes me and 

contains certain typical phrases I use. By 

having the actors say all these lines we can 

cast the better speakers in the leading roles. 
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SOUND EFFECT ROLES: “Episode Title Goes Here”
 
 
SOUND EFFECT ARTIST #1: 
SOUND EFFECT NAME GOES HERE  
SOUND EFFECT NAME GOES HERE 
SOUND EFFECT NAME GOES HERE 
SOUND EFFECT NAME GOES HERE 
 
SOUND EFFECT ARTIST #2: 
TRAIN SLOWING 
CAR CRASH 
 
SOUND EFFECT ARTIST #3:
SOUND EFFECT NAME GOES HERE 
SOUND EFFECT NAME GOES HERE 
 
CAST MEMBERS:
AUDIENCE APPLAUSE 
AUDIENCE WALLA WALLA 
WOMAN SCREAMS 
 

PRODUCTION NOTES: 
This page is provided by the Director and/or Sound Effects 
Chief and is used to organize the sound effect artists’ 
roles. Go through the script and find which effects are 
used at the same time and then split those effects up 
between several SFX artists. Then, use colored high-liter 
pens and highlight the scripts for the SFX artists so they 
can see which effects are coming up as they read along 
during the cue rehearsal and actual production. I usually 
assemble 3-5 SFX books with identical highlighted scripts 
and put them in plastic page slip covers, so they can be 
turned silently with one hand by the SFX artists. I also 
make little notes a page or so in advance of when the cue 
comes--to allow the artist to have that device ready ahead 
of time. 
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SOUND EFFECT HOW TO: “Episode Title Goes Here”
 
 
TRAIN SLOWING: 
 Drummer’s brush on washboard 
 
TRAIN WHISTLE: 
 Wooden train whistle. 
 
SWORD UNSHEATHED: 
 Pancake flipper scraped against metal mixing spoon. 
 
INTERMISSION CHIME: 
 Doorbell SFX device. 
 
SCREECHING AUTO BRAKES: 
 Train brake SFX device. 
 
TAPPING ON WINDOW: 
 Tapping on glass sheet. 
 
BLOWGUN: 
 Blowing through a cardboard tube, then slapping the tube. 
 
OPEN/CLOSE WINDOW: 
 Roll wooden cart back and forth on table. 
 
FIRE: 
 Crinkle plastic bag. 
 
SIREN:  
 Blow on siren whistle. 
 
 
RAIN: [A-5S] 
 Pre-recorded sample of jungle downpour on tin roof shack from  
     inside POV--1 minute long.  
 

PRODUCTION NOTE: 
This page is provided for, or by, the Sound Effects Chief 
explaining exactly how each sound effect is produced. It 
is then incorporated into the script so future productions 
won’t have to figure it out again. It is arranged, not 
alphabetically, but grouped by the SFX artists designated 
for these sounds. I include it in the front of the SFX 
books--also in a plastic page slipcover. 
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ENGINEER’S NOTES: “Episode Title Goes Here”

 

EQUIPMENT REQUIREMENTS: 
 
A typical notice here would be: This show requires the use of a filter 
mic for telephone effects (A “Go-Filter Mic” available from 
www.RuyaSonic.com’s Depot page.) Also, run the Sound Effects 
microphone through a reverb and be prepared to vary the amount of 
reverb as the director indicates by hand signals. 
 
MUSIC CUES: 
 
A complete engineer’s script will be provided with colored 
highlighting to show how long music cues run (through scenes and 
dialogue) and which characters are using reverb or filters, and when. 
 
 
1) The Program Name Goes Here theme: (0:14) [A-1] 
 Composer Name “Musical Title Goes Here”  
 It is used in intro and outro only. 
 
2) Action theme: 
 Composer Name “Musical Title Goes Here” [A-2] 
 (If it is a CD track, list the times of the cue)  
 
3) Sinister theme: 
 Composer Name “Musical Title Goes Here” [A-3] 
  
4) Graduation theme: 
 Edgar Elgar “Pomp & Circumstance, op.39 - March No. 1  [A-4] 
 in D major” from approx. 1:56 - 3:07 
  
5) Hypno theme: [A-5] 
 Pat D. Musica “Hypno Tripping” 
 
 

PRODUCTION NOTE: 
This page is provided to the engineer for technical 
requirements for the program. It also lists the music cues 
in order of appearance in the script. This page goes into 
an Engineer’s book that includes a full script which has 
the music and mic. effect cues highlighted. During 
production, the engineer will read along and see where the 
music and effects start and end. I usually put these pages 
in plastic slip covers so they can be turned easily with 
one hand. This page also serves as the table of contents 
for the music/sampled sound effects CD (or MiniDisk or 
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whatever playback device you use.) See the [A-1] [A-2] 
etc.
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NOTE: 
This page is for the writer to list changes made to the 
script after initial production or other notes about 
possible problems, the origins of character names, or 
anything else the writer may want to write down. I often 
find it a useful place to keep scenes that were cut--just 
in case I want to restore them in a future re-write or 
later episode. 
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TEMPLATE NOTES: 
This radio script template allows you to write in the 
final format of the script. This classic “block” style 
format uses a 12-point Courier font of 1940s typewriters, 
although I’ve bolded it to make it photocopy better. Each 
page of script in this format runs about 55 seconds of air 
time--it depends on the pace of the direction. Other 
conventions of the format are explained in the script 
itself.   
 

Let me stress a few conventions I use in my radio drama scripts that 
differ from conventional script styles for stage and screen. 
 
DIALOGUE DELIVERY INSTRUCTIONS 
For dialogue, I specifically recommend that you make full use of 
underlines, ellipses [But...] and parentheticals [(DRUNK) (WHISPERS) 
(PAUSE) etc.] to indicate how the actors should deliver the lines. 
There's never much rehearsal time in radio drama, so these 
instructions quickly convey just what the writer intended. We are 
working live, remember. 
 
Some directors wish to let the actors deliver lines the way they feel 
it, and hope they get it right. However, as the writer, I wrote it one 
way and want to make sure it reads easily and is delivered as I 
intended it. Actors can still bring nuance and interpretation to their 
parts, but I don't want them mis-understanding what the lines are 
about--especially live! Clarity is paramount in audio theatre. Do it! 
 
CHARACTERS IN A SCENE 
After the “slug line” identifying a new scene, I include the character 
names used in the scene, to alert any actors who are sitting down to 
get up and come to the mic. It also allows for quick casting calls in 
rehearsal. (“I need Debs, Fido, and Cap’n Twitshire for this scene.”) 
 
Here's an example of the slug line with featured characters for a 
scene: 

SCENE FOUR - EXT. PIRATE SCHOONER - DAY 
    (NEVILLE, TERESA, CATALINA, BAPTISTE, LOOKOUT) 

 
CUE NUMBERING 
Also, when I'm writing my script, I just put an “X” instead of a 
number for the cue. Then after I've finished with all my drafts, I 
replace the Xs with numbers. 
 
Example: 
X.  NEVILLE:  (CALLS OUT) Ahoy, you skulking dogs! 
 
X.  BAPTISTE:  (DISTANT) Aye, Cap'n!    
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MARKING UP THE FINAL DRAFT 
After I've printed out the production draft, I take a Sharpie pen and 
hand-write the letter "Q" alongside any cues where the actor, music, 
or SFX crew should wait for the director to cue them. Everybody will 
work off of the marked up script. This is usually in specific places: 
 
1) On the first dialogue cue following a music cue--so the director 
can wait until the music cue is established or fades. This is often at 
the beginning of a new scene. 
 
2) On a dialogue cue after an important sound effect--so that effect 
can "clear" and not get stepped on by the actors. 
 
3) On a music or SFX cue that must precisely follow the director's 
timing. Say, where a gunshot SFX cue is followed by a suspenseful 
pause and then the sound of a body dropping to the floor. 
 
These "Qs" easily tell everyone to wait for the director. They make 
rehearsals and performances run much smoother. Since it's handwritten 
and bold, these “Qs” really stand out amidst the typed text. 
 
What I do when typing a script is substitute an asterisk for the 
period after a cue number, so I can remember where these hand-written 
"Q" marks should go. So, you'll see: 
 
2* NARRATOR:  Some dialogue goes here. 
 
When marking up scripts, I also use a Sharpie pen to circle the walla 
walla cues (background crowd sounds). This way the cast can all see 
when walla is required.  
 
PREPARING RADIO SCRIPTS FOR PRODUCTION 
If you're using my script template, also take a look at my website's 
pages about preparing for production. The advice on using hi-lighters 
for the engineers and SFX department are real time savers. 
http://www.RuyaSonic.com/pre-prod.htm 
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HOW TO CUSTOMIZE THIS TEMPLATE FOR YOURSELF 
1) Make a copy of the template under a new name and store 
it as a template in your MS Word template folder. They end 
in .dot, instead of .doc for the file name’s extension. 
 
2) Now, print out the template, so you’ll have a paper 
reference of the “how to” aspects. 
 
3) Go through the template and delete all my notes, like 
this one. You may also choose to delete most of the dummy 
dialogue and other radio cues.  
 
4) Go to the first page and use the MS Word “search and 
replace” feature to put your own info in place of my 
generic entries about author name and production company. 
 
5) Go to the “View” menu, click on “Headers and Footers” 
and replace the footers entries for the production company 
address and e-mail address with your own info. 

 6) Make sure the floating toolbar is visible. Go to the 
"View" menu, click on "Toolbars" and check the "Radio 
Script" toolbar. You may wish to uncheck the standard Word 
"Formatting" toolbar since there are several duplications 
of commands. 
 
7) Now, save the template again to whatever name you want. 
This will be your regular starting template for writing 
radio scripts. Close the document. 
 
8) To write a script, go to the “File” menu, click on 
“New”  and choose to base the document on your template. 
Then use MS Word’s “search and replace” feature to put in 
your program name and episode title throughout the 
document and also in the headers.  
 
Now, just remember--”write between the ears” and you’ll be 
a radio dramatist in no time!  

TONY’S TRICK TO WORKING FASTER 
I make a second copy of my radio master template. On it, I 
go to the “Format” menu and alter the color for the 
following styles from black to: 
 
-- Red for Radio Music 
-- Blue for Radio Sound  
-- Green for Radio Scene  
-- Magenta for Radio Notes 
 
I use this colored template when writing a script. It 
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makes it very easy to see the sound and music cues. 
However, when I print the script, I must remember to 
attach the black master template and click on "update 
styles" or these cues will not print as darkly and thus, 
be hard to read for rehearsals and performances. 

PRINTING BY SECTION: 
This script uses many section breaks to allow for quick 
printing. The pages used for actors copies are  
Sections 1-3. You can print just these sections by going 
to the MS Word “Print” page, and designating pages: S1-S3. 
To print just a few pages from within a section, specify a 
page range first, like p18-24 S3  (Section is always 
last). 
 

Here’s a breakdown of the sections: 
Section 1 - Title (fly) page 
Section 2 - Cast listing page 
Section 3 - Script pages (dialogue, music, SFX) 
Section 4 - Casting Evaluation page 
Section 5 - Casting Monologues 
Section 6 - Director’s Notes 
Section 7 - Sound Effects Chief’s notes 
Section 8 - Engineer’s Notes 
Section 9 - Writer’s Notes. 

 

WORD VERSIONS: 
This template was saved using MS Word 6.0, which doesn’t 
use the Visual Basic macros of later Word versions and 
thus isn’t vulnerable to the infamous macro viruses that 
wipe out hard drives or cause other mischief. It will 
easily translate into later versions of Word. You can save 
your own templates and scripts as documents in whatever 
version of Word you are using. The section printing and 
swapping templates to overlay color or black styles may be 
a little tricky, so see your Word help files for more 
information. 

EXTRA BONUS:  
I’ve created a blanked out version of this template—so all 
the instructional text is gone. You can download it at 
http://www.ruyasonic.com/wrt_template.htm#BLANK  

GOOD LUCK! 
Tony Palermo <Palermo@RuyaSonic.com> 
Revised: November 2005 
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